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Warning

Using the supplied equipment in a manner not specified by Sunrise Telecom may impair the protection 
provided by the equipment.

Warning

This is a Class 1 LASER product. Avoid looking directly at the Transmitter source. For added safety, turn 
off the laser when not in use.

End of Life Recycling and Disposal Information

DO NOT dispose of Waste Electrical and Electronic Equipment (WEEE) as unsorted municipal waste.  For 
proper disposal return the product to Sunrise Telecom. Please contact our local offices or service centers 
for information on how to arrange the return and recycling of any of our products.

EC Directive on Waste Electrical and Electronic Equipment (WEEE) 

The Waste Electrical and Electronic Equipment Directive aims to minimize the impact of the disposal of 
electrical and electronic equipment on the environment.  It encourages and sets criteria for the collection, 
treatment, recycling, recovery, and disposal of waste electrical and electronic equipment.
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1	 Contact and Warranty

1.1	 Customer Service

Sunrise Telecom Customer Service performs the following functions: 

•	 Answers customer questions over the phone on such topics as product operation 
and repair.

•	 Repairs malfunctioning RxT promptly.

•	 Provides information about product upgrades.

The warranty period covering the RxT is one year from the date of shipment on 
hardware, software, accessories, and the battery. 

A Return Merchandise Authorization (RMA) Number is required before any product 
may be shipped to Sunrise Telecom for repair. Out-of-warranty repairs require both 
an RMA and a Purchase Order before the unit is returned. All repairs are warranted 
for 90 days.

Please contact Customer Service if you need additional assistance:

Customer Service
Sunrise Telecom Incorporated

302 Enzo Drive

San Jose, CA 95138 U.S.A.

Tel: 1 408 360 2200 or 1 800 701 5208 

Fax: 1 408 363 8313

Internet: http://www.sunrisetelecom.com

E-mail: support@sunrisetelecom.com

Offices

Sunrise Telecom offices are located around the world:

HEADQUARTERS
302 Enzo Drive, San Jose, CA 95138, USA

Tel: 408-363-8000, Fax: 408-363-8313 

info@sunrisetelecom.com

SUNRISE TELECOM - ATLANTA
3075 Northwoods Circle, Norcross, GA 30071, USA 

Tel: 770-446-6086, Fax: 770-446-6850

catv@sunrisetelecom.com
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SUNRISE TELECOM CHINA
Room 1503, Tower 3 , No.1, Xizhimenwai Street

Xicheng District, Beijing, 100044, CHINA

Tel: +86-10-5830-2220, Fax: +86-10-5830-2239

info@sunrisetelecom.com.cn 

SUNRISE TELECOM FRANCE SAS
ZA Courtaboeuf 2 - Immeuble le Ceylan

6 Allée de Londres 91140 Villejust, FRANCE

Tel: +33 (0) 1 6993 8990, Fax: +33 (0) 1 6993 8991

info@sunrisetelecom.fr 

SUNRISE TELECOM GERMANY GmbH
Grabenstrasse 1, 16 Mössingen GERMANY

Tel: +49 7473 378 2400, Fax: +49 7473 378 2424

info@sunrisetelecom.de 

SUNRISE TELECOM TAIWAN
21, Wu Chuan 3rd Road, Wu-Ku Hsiang

Taipei County, 248, Taiwan, R.O.C.

Tel: +886-2-5578-0788, Fax: +886-2-2298-2575

info@sunrisetelecom.com.tw
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1.2	 Express Limited Warranty

This Sunrise Telecom product is warranted against defects in materials and work-
manship during its warranty period. The warranty period for this product is contained 
in the warranty page on http://www.sunrisetelecom.com. 

Sunrise Telecom agrees to repair or replace any assembly or component found to 
be defective under normal use during this period. The obligation under this warranty 
is limited solely to repairing or replacing the product that proves to be defective 
within the scope of the warranty when returned to the factory. This warranty does 
not apply under certain conditions, as set forth on the warranty page on http://www.
sunrisetelecom.com. Please refer to the website for specific details.

THIS IS A LIMITED WARRANTY AND THE ONLY WARRANTY MADE BY SUNRISE 
TELECOM. SUNRISE TELECOM MAKES NO OTHER WARRANTY, REPRESEN-
TATION OR CONDITION, EXPRESS OR IMPLIED, AND EXPRESSLY DISCLAIMS 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICU-
LAR PURPOSE AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS.
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2	 Platform Overview

2.1	 Unpacking 

To unpack and test a new test set:

1.	 Remove the packing list, test set, and accessories from the shipping container.

2.	 Inspect all parts and immediately report any damage to the carrier and to Sunrise 
Telecom.

3.	 Verify that all parts specified on the packing list were received.

4.	 Complete the Warranty Registration Card and return it immediately to Sunrise 
Telecom.

Sunrise Telecom must receive the Warranty Registration Card in order to provide 
software updates.

2.2	 RxT Platform Notes 

Press the blue Alt button and F6 to move between the RxT module and the computer 
system desktop. See the hardware notes and graphic.

On the Windows desktop, access useful basic computer tools:

System: Access RxT system information and setups.

•	 Brightness Control: Set the screen brightness on the LCD Control popup win-
dow.

•	 Volume Control: Mute, increase, or decrease the speaker and microphone 
volume on the System Audio Control pop up.

•	 Regional Setup: Enter the current Date, Time, and select your Time Zone and 
the GUI language on the pop up window.

•	 Network Setup: Enter the local settings; these settings apply to RxT itself, NOT 
the test ports. Proceed carefully-changing these settings may cause the module 
to lose connection with the system.

•	 Wireless Network Setup: Configure a wireless Ethernet network connection.

•	 GPS & Location Tags: Get RxT location information via GPS data.

•	 RxT Module GUI: Restart the RxT module GUI.

•	 Stop RxT Module GUI: If RxT Tools does not respond, it may be they were 
already open. Use Stop RxT Tools to regain control, then try RxT Tools again..

Reference: Access helpful testing and technology documents, as well as a dem-
onstration of the RxT GUI and the .pdf version of the Help system.

Apps: Access test supporting applications: 

-- Fiber Scope: Control an attached Sunrise Telecom Fiberscope, if the option 
was purchased. See the documentation which came with the Fiber Scope 
for operating instructions.

-- Remote Desktop: Control RxT via a VNC viewer. To download the program 
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for the controlling Windows or Linux computer, visit http://www.realvnc.com/
products/free/4.0/download.html.

-- Network Decoding: Analyze saved results and file captures; see http:www.
wireshark.org/docs/ for help using the WireShark application. 

-- Calculator

-- Text Editor: Launch a text editor.

-- MPlayer: Launch a media player. See http://www.mplayerhq.hu.

•	 RxT Tools: Access key RxT system functions - 

-- Software Option 

-- Software Upgrade

-- Calibrate Touchscreen: Recalibrate the touch screen if screen response 
seems off. Touch each ‘x’.

-- System Administrator

-- System Status 

-- Software Recovery: Recover and continue the upgrade; use, for example, if 
power was lost while performing an upgrade. Press the appropriate button 
to upgrade the Platform or the test Module, as required.

Web Browser: Launch a Firefox web browser. Requires internet connectivity. In 
the Preferences screen, use the hard Esc button to close the window and enter 
Firefox. Use File > Quit to close the program.

File Manager: Access the Linux Gnome Nautilus desktop file management func-
tions, including the tree view of all system files.

E-mail: Access a mail/calendar client. http://www.claws-mail.org/ for information.

Power: Shut down (power off) or Reboot (restart) RxT; see also the hardware 
Power button.

Eject USB Drive/2: Safely eject a USB memory drive at USB1 or USB2. See the 
USB notes.

•	 Important Note - Caution: External memory devices must be ejected prop-
erly, using the appropriate button, in order to safeguard your data. Failure 
to eject a drive properly may result in lost data.
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2.3	 RxT System Overview Graphic

 
Figure 1	 RxT Front Overview



10

RxT Platform 

2.4	 Hardware Notes

RxT is a touch screen test set; use your finger or a stylus to make selections. How-
ever, you may find attaching and using a mouse is fastest. Plug the power cord in 
on the right side, and press and hold the top round button for a few moments to 
turn the unit on (or off).

No liquids. RxT has been designed to move water away from its vents, but it is 
not waterproof; avoid spills and liquids.

Press the red power button to power on. You will see a Sunrise Telecom screen, 
then the unit will pause on the RxT Platform desktop, then your test application will 
automatically launch.

Ports - Right Side

 USB 2 host 
port

USB 2.0 port

Mini USB 
client

No user application.

 LAN
10/100T Ethernet port. Use for a network connection; use 
for remote control, realGate, system updates.

Ports - Left Side

 

Serial port; no user application.

 

Plug in the AC charger. See the Battery notes.

Non Test Ports - Top

  USB 1 host port

USB 2.0 port

 Earphone Plug in a headset.

 Mic
Plug in a microphone.

In addition, the top of the unit features GPS and  Wifi connectivity. Just in front on top is 
a built-in speaker.

Access test modules from the rear.

 Access the battery pack from the rear. See the Battery notes.

 USB Mouse Troubleshooting Hint: For best functionality, use a ferrite mouse, 
or place a ferrite bead on the USB mouse cord. 
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Ports - Top

The top connector panel holds the test ports and a USB 2.0 host port.

•	 SFPs are hot-swappable. Handle the bale carefully, and avoid touching the end 
of the connector. 

Front Buttons

See a graphic, “Figure 1 RxT Front Overview” on page 9.

 

The red round top button is the power on/off button. 
Pressed briefly: The unit powers on, or, if on, the restart/reboot 
query window appears. Normal shut down.
Hold several seconds: Forces a hard restart.

 

Start/Stop measurements; it takes a few moments for each 
action to occur.

 ,   

Use the up, down and left and right arrowhead buttons on the 
right side of the chassis to move around in the screens. 

ESC Go back one screen.

Alt Press the blue Alt button to use the alternative blue functions 
on the F-keys.
F1, F2: Decrease or increase system volume.
F3, F4:Decrease or increase screen brightness.
F5: Bring up the on screen keyboard
F6: Toggle between the RxT Platform and the RxT application, 
and any other open functions (e.g. the File Manager)

F1-F6 Special function keys; press one to activate the function on the 
screen button directly above it. Used with the blue Alt key for 
system functions (see Alt above)

External Storage

If you are using an external form of storage on the RxT (USB drive, etc.) (and have 
written files to the external volume), you must cleanly dismount the volume from 
RxT Platform before removing it, or the files may not be written safely to the external 
storage volume. 

Use a desktop icon to safely remove hardware (eject the USB drive).
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2.5	 Battery 

The battery charge status is represented by an icon in the Status Bar.

The hardware battery icon reflects charging status; green-full charge, orange-
charging, red-low power; the plug icon indicates the unit is plugged in and charging.

The screen icon shows as green when the battery is fully charged, or connected 
to AC power. The green diminishes and red fills the icon as the available power 
decreases. When the battery is charging (note the plug icon within), the red will 
give way to green.

When there is approximately 10% battery life remaining, you will see a warning 
message pop up to remind you to plug in the power adapter.

At approximately 4% remaining power, RxT will pop up warning, save results for 
the test in progress, then shut down. 

To replace the battery, remove the two screws at the bottom of the back battery cover. 
The screws will stay attached to the cover. Pull the battery pack out, then replace it 
with the new one. Replace the cover, and replace the screws, without overtightening.

Battery Care and Storage

Lithium Ion battery packs (also referred as Li-ion, secondary, or rechargeable) are 
small, compact, with high energy concentration, and ideal for providing long lasting 
power to portable test equipment in demanding applications. Li-ion battery packs 
contain Li-ion cells and battery monitoring & protection circuitry, both sealed in a 
plastic container or wrap that shall not be disassembled. For safety reasons these 
batteries packs and products containing them MUST be used, charged, and handled 
properly, according to the manufacturer’s recommendations. Improper use can result 
in product damage, electrolyte leaks, serious injury, and fire hazard.

Sunrise Telecom’s Li-ion battery packs are tested and certified to UN38.3 and re-
lated safety regulations. 

Performance and life expectancy of batteries depend heavily on how battery packs 
are used. In order to ensure safety, be sure to carefully read and understand this 
document and to keep it handy. If you have any questions or concerns, please contact 
Sunrise Telecom Incorporated immediately at 1-800-701-5208 / 1-408-360-2200, 
support@sunrisetelecom.com or visit http://www.sunrisetelecom.com/support.

Lithium-Ion Advantages
•	 The biggest Li-Ion advantage batteries have is the improvements in cell voltage 

and capacity over nickel cadmium (NiCd) or nickel metal hydride (NiMH) bat-
teries. Li-Ion batteries are therefore said to have a much higher energy density 
compared with NiCd or NiMH batteries. Unlike NiCd or NiMH batteries, Li-Ion 
batteries have no ’r;memory’ effect. This translates into a more productive test 
set that can be used un-corded for longer periods or handle higher end applica-
tions, which are usually more demanding.

•	 Much lighter batteries, compared to the same capacity NiCd.

•	 No cadmium. As most people know, cadmium is highly toxic and is known to 
accumulate in biological systems, which is why NiCd batteries must be disposed 
of carefully and in the right places, following local regulations.
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Although there are many other technical advantages that make Li-Ion the current 
chemistry of choice for high-end portable equipment, much greater care is required 
for Li-Ion batteries. Fortunately, more precise equipment and monitoring systems 
are built-into these battery packs for performance and safety reasons. A more rigor-
ous approach, plus a profound awareness of Li-Ions, is vital to the wellbeing and 
SAFETY of users, bystanders, equipment, and premises. It’s important to remember 
that, like other batteries, these batteries too will explode if abused!

General Warnings
•	 Do not place the battery pack or cells on or near fires, heaters, other high tem-

perature locations, or apply heat to the battery.

•	 Do not pierce the battery with any sharp objects, strike the battery with a ham-
mer, tools, or heavy objects, step on the battery pack, or otherwise damage the 
outer casing.

•	 Do not subject the battery pack to strong impacts or shocks.

•	 Do not expose the battery to water or any other type of liquid, or allow the battery 
to get wet.

•	 Do not leave the battery in direct sunlight, and avoid storing spare battery packs 
inside cars in extreme hot weather. Doing so may cause the battery to generate 
heat, rupture, or ignite. Using the battery in this manner may also result in a 
loss of performance and a shortened life expectancy. When a battery becomes 
too hot, the built-in protection circuitry is activated, preventing the battery from 
charging further. Heating the battery can destroy the safety devices, and can 
cause additional heating, rupture or ignition of the battery cells.

•	 Never short-circuit, reverse polarity, disassemble, damage or heat the battery 
pack over 100°C (212°F).

•	 If an exposed lithium-ion battery does start a fire, it may burn even more vio-
lently if it comes into contact with water or even the moisture in the air. DO NOT 
THROW WATER ON A BURNING LI-ION BATTERY! A class C fire extinguisher 
must be used.

•	 Although most battery packs have protected (recessed) connectors, do not carry 
individual battery packs in your pockets as they could short-circuit against other 
metal items.

•	 In the case of a high-impact event to the test system or the battery pack (e.g. car 
crash or drop > 0.75m/30 in) you must carefully inspect the battery for damage 
and properly discard it if damaged. Always observe the battery carefully for at 
least 20 minutes after an impact.

•	 The pack may look fine but a perforation or damaged wire means the pack must 
be disposed of according to local regulation. Contact Sunrise Telecom if in doubt.

•	 Do not disassemble or modify the battery pack. The battery contains safety and 
protection devices which, if damaged, may cause the battery to generate heat, 
rupture or ignite.

•	 Any modification may damage the battery pack or cells and will invalidate any 
warranty claim.

•	 If you happen to get any electrolyte from the cells on your skin, wash thoroughly 
with soap and water. If in your eyes, do not rub. Rinse thoroughly with water and 
seek medical assistance.

•	 Keep battery packs away from untrained personnel and children!
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Charging and Storing the Battery Pack
For safety reasons, rechargeable battery packs are not fully charged when they are 
shipped. Please read the following instructions carefully:

•	 New battery packs need to be fully charged and discharged up to five times 
before performing at full capacity.

•	 Always use the Sunrise Telecom’s charger that came with the device. Do not 
attempt to charge the battery pack by any other means.

•	 The portable instrument, its external chargers, and the battery pack itself continu-
ously monitor the conditions of the cells for safety and maximum performance.

•	 Do not use the Sunrise Telecom’s Lithium Ion Charger on other lithium batteries 
or on any other type of battery – fire or explosion may occur. 

•	 Never modify or repair the charger supplied.

•	 Never use a NiCd charger or any other charger to recharge the Li-ion battery 
pack as this is very dangerous.

•	 Never charge your Li-Ion battery pack near heat or flammable objects.

•	 The required charging time will depend upon the remaining charge level of the 
battery, and will vary from product to product. Charging the battery while the test 
set is being used will increase the charging time. Required charging time may 
also increase at lower temperatures.

•	 The temperature range over which the battery can be charged is typically 0°C 
to 45°C (32°F to 113°F). Therefore, charging efforts outside the prescribed 
temperature range may automatically be blocked by the protection circuitry of 
the battery pack.

•	 If a battery pack can not maintain charge for long periods, even when it is being 
charged correctly, this may indicate it is time to replace the battery.

•	 If the product or battery pack becomes too hot to the touch during charging, 
disconnect and switch off immediately. Contact Sunrise Telecom.

•	 Do not charge battery packs if the battery has expanded or swollen in size, or if 
the battery cells have been punctured, even if this is the first time the battery is 
going to be charged.

•	 Do not charge or use the battery if any mechanical damage has occurred.

•	 Do not continue charging the battery if it does not recharge within the specified 
charging time. Doing so may cause the battery to become hot, rupture, or ignite. 
Please consult the product’s manual and data sheet.

•	 Because batteries utilize a chemical reaction, battery performance will naturally 
deteriorate over time, even if stored for a long period without being used. In ad-
dition, if the various conditions such us charge, discharge, ambient temperature, 
etc. are not maintained within the specified ranges, the life expectancy of the 
battery may be shortened, or the device in which the battery is used may be 
damaged by electrolyte leakage.

•	 Storage: For long term storage, the battery pack should be stored at room tem-
perature (around 20°C/68°F)), charged at about 30 to 50% of its capacity. We 
recommend that spare battery packs are charged and used at least once per 
year to prevent over-discharge.
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•	 If you have spare (extra) battery packs, rotate the packs regularly, so they all 
stay active and avoid over-discharge. It is recommended to charge and use 
battery packs at least every three months. Battery packs shall not go without 
reconditioning (recharging) for more than six months.

•	 After extended storage battery packs may reach deep discharge state and/or 
enter into sleep mode. For safety reasons, Li-ion batteries in deep discharge 
state may take up to 24 hours to pre-recharge, before starting the regular fast 
charging cycle. Charging indicators (e.g. LEDs) may not turn on during the pre-
charging state.

Using Battery Packs

For the expected performance of each individual battery pack and test set, please 
refer to their specific manuals and data sheets.

•	 Sunrise Telecom battery packs shall only be used with the Sunrise Telecom 
product for which they were intended to be used. Follow the product’s low bat-
tery indication and warnings. Do not over discharge a Li-Ion battery pack. If the 
voltage does drop below specifications, and you can get your battery to take 
a charge, it may not give its full capacity and deterioration in performance will 
occur. This will invalidate all warranty claims.

•	 Do not discharge the battery pack using any device except for the specified test 
set it came with. The test set constantly monitors and controls the discharge rate 
to keep it within specifications. If used in devices aside from the specified devices, 
it may damage the performance of the battery pack, reduce its life expectancy, 
and if such device causes an abnormal current flow, it may cause the battery to 
become hot, rupture, or ignite, and could cause serious injuries.

•	 The temperature range over which the battery can be discharged is -10°C to 
60°C (14°F to 140°F). Use of batteries at temperatures outside this range may 
damage the performance of the battery pack or may reduce its life expectancy.

•	 To avoid short circuits, make sure the battery pack’s contacts are not exposed 
when transported outside the intended device (e.g. spares).

•	 Every deep discharge cycle decreases their capacity. Battery life will be extended 
by proper storage, and by charging the pack at least once per year to prevent 
over discharge.

   Battery Pack Disposal

•	 Batteries must be recycled or disposed of properly.

•	 Follow local regulations and ordinances for the disposal batteries.

•	 Do not trash battery packs in the garbage can.

•	 Before disposing the battery pack or cells, insulate any exposed terminals with 
adhesive tape or similar material to prevent short circuits.
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Shipping and Transportation (Air)
•	 Air transportation of Li-ion batteries is regulated in several countries, and by 

United Nations through the International Air Transportation Association (IATA) 
Dangerous Goods Regulations, among others. Please check local regulations 
and with the common carrier before shipping Li-ion battery packs or products 
containing relatively large Li-ion battery packs.

•	 As of January 1, 2008, the US Department of Transportation (DOT) through the 
Pipeline and Hazardous Materials Safety Administration (PHMSA) no longer 
allows loose lithium batteries in checked baggage.

•	 Sunrise Telecom’s Li-ion batteries are tested in accordance with specifications 
detailed in UN 3090 (UN manual of Tests and Criteria, Part III, subsection 38.3). 
This safety precaution safeguards against the shipment of defective battery 
packs.

•	 Do not ship or carry recalled or damaged batteries on an aircraft. Check battery 
information and instructions at Sunrise Telecom’s website or contact Customer 
Support at 1 (800) 701-5208 / +1 (408) 360-2200 or support@sunrisetelecom.
com.

•	 If the original packaging is not available for shipping spare batteries, effectively 
insulate any exposed battery terminals by isolating the batteries from contact 
with other batteries and metal. Do not permit a loose battery to come in contact 
with any metal objects.

IATA Classification
Medium and large capacity Lithium-ion battery packs may be classified as Class 
9 – Miscellaneous dangerous goods. Shipments of such products must be identi-
fied by a Class 9 label on the shipping package and may be considered restricted 
cargo in passenger aircraft. Individual Li-ion battery packs must be declared as:

•	 UN 3480 for Lithium-ion batteries or battery packs being shipped alone. If they 
are contained inside a piece of equipment or packed along with a piece of equip-
ment, they must be declared as:

•	 UN 3481 for Lithium-ion batteries contained in equipment

•	 UN 3481 for Lithium-ion batteries packed with equipment.

Li-ion (Secondary) Battery Category Definition & Restrictions

Relative 
Capacity

Capacity Watt-
hours

Equiv. 
Lithium 
Content 
(ELC)

UN38.3 
Tested

Applicable Shipping Regu-
lations

Small <100 Wh <8g Yes Ground: Non-restricted
Air: Non-restricted

Medium 100 to 312 Wh 8g to 25g Yes Ground: Non-restricted
Air: Fully-regulated Class 9 
hazardous material

Large >312 Wh >25g Yes Ground: Fully-regu-
lated Class 9 hazardous 
material
Air: Fully-regulated Class 9 
hazardous materia
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Note: Check with your carrier for any required forms, labels and local regulations. 
Li-ion battery pack capacity may be printed on the battery.

Product Registration and Calibration
•	 Registration is a very important step in the ownership of your instrument.

•	 For warranty and safety purposes all Sunrise Telecom products must be regis-
tered by the owner and/or end user. 

•	 Customers would not only benefit from service notes and safety notifications, 
but from access to a wide range of improvements (e.g. software updates, new 
features, new documentation, etc.). Please follow the registration instructions 
that came with your product.

•	 Registration is the sole responsibility of the end user and owner. Products must 
also be registered, and contact information must be updated, whenever the end 
user, responsible person, or contact information changes.

•	 Customer and end user shall follow the recommended calibration, verification 
and/or preventive maintenance cycles for each specific product, to keep it under 
warranty and assure safety. During these procedures the battery pack will be 
checked for any sign of degradation, leakage or any other possible defect that 
may affect safety. 

•	 Refer to the specific manual and data sheet for the suggested maintenance 
period.

•	 Copy of this document shall be kept with the product at all times.

Customer Service Contact Information
SUNRISE TELECOM INCORPORATED

302 Enzo Dr., San Jose, CA 95138, USA

Email: support@sunrisetelecom.com

Tel.: +1 (800) 701-5208 / +1 (408) 360-2200

Web: http://www.sunrisetelecom.com/support

Limited Warranty
SUNRISE TELECOM INCORPORATED WARRANTS ITS BATTERY PRODUCTS 
TO BE FREE FROM DEFECTS IN MATERIAL AND WORKMANSHIP, UNDER 
NORMAL USE AND IF PROPERLY INSTALLED, FOR A PERIOD OF ONE YEAR 
FROM DATE OF PURCHASE.

Notice: The information presented in this document is generally descriptive only and 
it is not intended to make or imply any representation, guarantee or warranty with 
respect battery packs. Please refer to individual product manuals and data sheets 
for specific information. This document is subject to change without notice. Contact 
Sunrise Telecom for the latest information 
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2.6	 USB Drive Notes

USB drives, also known as thumb drives and USB sticks, etc., may be used with the 
RxT system. Plug them in in a host USB slot (see the diagram, “Figure 1 RxT Front 
Overview” on page 9). Several seconds after plugging a USB drive, a “Ready 
to use” message will appear (press OK).

To dismount a drive
Touch Eject USB Drive/Eject USB Drive 2 on the system desktop, as applicable, or

In File Manager, select usbdrive under the left-hand Places, then select File > 
Unmount Volume.

 USB Drive Tips
If you see a “Device not recognized” message upon inserting the USB drive, 

remove it and reinsert it.

Make sure the drive is fully inserted into the port if it is not recognized.

Using a partioned drive with RxT made lead to unexpected results. If so, use a 
nonpartioned drive instead.
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2.7	 RxT Carrier & MTT Modules

The RxT Carrier Module (RXT2000A) is an intelligent module that accepts existing 
MTT modules and adapts their features to the new RxT. The RxT Carrier is always 
packaged with MTT modules in the RXT2xx0 and RXT2xxX series.

Frequently Asked Questions

Are all MTT modules supported by the RxT Carrier?

No, only a select number of MTT modules are currently supported. 

What exactly is the RXT2xx0SW-GUI?

The RXT2xx0SW-GUI family of part numbers or orderable items includes:

•	 The delivery or factory installation of the Test Application’s Graphical User Inter-
face (GUI) required to operate an RXT2xxX test module.

•	 The licenses for any feature, hardware, or software options purchased for each 
particular module.

The RXT2xx0SW-GUI must be ordered for each individual module. For example, if 
you are transferring the licenses for 10 existing MTT modules, you must order 10 
RXT2xx0SW-GUI.

What is “Forward Compatibility Mode”?

Forward compatibility mode is used to bring legacy MTT modules to the RxT plat-
form, preserving most of their original GUI structure and functions. 

The operation of the module stays familiar with that on the SSMTT platform, with 
added file management, realGATE support, USB import/export, bigger screen, touch 
screen features, and great usability improvements.

Once an RXT2xx0SW-GUI Test Application has been installed in an RxT Plat-
form, will it be available to any RXT2xxX module combination inserted?

The GUI is installed directly in the RxT Carrier (not in the RxT Platform) to allow 
maximum portability and test module sharing. If a fully configured RXT2xxX module 
is inserted into a brand new RxT Platform, it will work right away. Each RXT2xx0SW-
GUI only needs to be installed once on each RxT Carrier.

If I have already obtained the RxT GUI for an MTT module, can I just install it 
in multiple RxT Carriers?

Yes, you can install the Test Application GUIs for different module types into a single 
RxT Carrier. 
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•	 When an MTT module is inserted for the first time, the RxT will recognize it and 
ask the user to install the appropriate Test Application GUI for the new module. 

•	 The GUI for each module type only needs to be installed once. However, the 
matching option file must be loaded for each individual module

Can the software options of an existing MTT module be moved to an RxT 
Carrier?

Yes, they are referred as the “Option File”. 

For example, a customer received an RxT Carrier when they ordered an RXT2500 
and now they want to move their existing MTT-38 to the RxT Carrier and keep the 
licenses (features) they originally ordered with their older SSMTT-C. They must 
order the RXT2380SW-GUI to convert the original features into an RxT option file 
and get a copy of the Test Application GUI to install. 

Once an MTT module’s option file is loaded into an RxT Carrier, this RxT Carrier 
will remember the module in the future (no reinstallation required.)

Option files are identified by the MTT module’s serial number and are not transfer-
able to other MTT modules. Each MTT module must have its own option file loaded 
in the RxT Carrier being used; otherwise the optional (paid) features would not be 
available.

Can multiple MTT modules of the same kind be used with one RxT Carrier?

Yes, you can register multiple MTT modules of the same or different kind into one 
RxT Carrier. You must obtain and load the option files for each of the MTT modules.

Can option files be installed in multiple RxT Carriers?

Yes, the option file for a particular MTT module can be imported into all the RxT 
Carriers the customer owns. This is an important part of RxT’s module portability 
and sharing. You must have the target RxT Carrier and particular MTT module 
(exact serial number), go through the Test Application GUI installation process as 
prompted by the unit, and manually import the matching option file.

Can I buy multiple RxT Carriers for all their MTT modules?

Yes, you can match each MTT module to a dedicated RxT Carrier. This would offer 
maximum portability as the resulting RXT2xxX modules will carry all the licenses, 
configurations, test results, and reports, as well as remember the last configuration 
used (independent of the RxT Platform they are inserted to). 

In this case, the module can be moved from platform to platform without having to 
install any software or import licenses.
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Where are all the test-related files stored, on the RxT Platform or the RxT 
Carrier?

The RxT Carrier has its own storage memory. All test results, test reports, test pro-
files, protocol capture files, etc are stored in the RxT Carrier, and can be exported/
imported to/from USB memory and realGATE.
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2.8	 Loading MTT Modules into RxT

Installing the Test Application GUI for a New MTT Module

Use this procedure if the particular type of MTT module has never been used before 
with the target RxT Carrier.

1.	 Turn the RxT Platform off.

2.	 Insert the new MTT module type in the RxT Carrier’s slot, and make sure it is 
completely seated. This new combination is now referred as an RXT2xxX module. 
For example, if an MTT-38 is inserted in an RxT Carrier, the resulting combina-
tion will be referred as RXT238X.

3.	 Insert the RXT2xxX in the RxT Platform

4.	 Turn the RxT on.

5.	 Wait until the RXT2xxX splash screen shows up recognizing the module and 
asking for “New Module Installation”. (If the test application GUI starts automati-
cally, it would be an indication that the GUI was already installed, so follow the 
software update procedure instead)

6.	 Press the New Module Installation icon

7.	 Press Version List. Software versions available in the root of a local USB drive 
or Sunrise Telecom’s public server will be displayed.

8.	 Select the latest (higher) software version available.

9.	 Check Reboot.

10.	Verify that the AC/DC charger is plugged in (the battery icon on the top right of 
the screen shows an AC plug inside the icon).

11.	Press Install, and wait for the whole process to finish. It may take a few minutes, 
depending on the network connection speed and the size of the installation 
package.

12.	The unit should reboot when finished.

13.	The Test Application GUI should start.

14.	Follow the Option File loading procedure below.

Loading New MTT Option Files to an RxT Carrier

Adding or registering new MTT modules to an RxT Carrier is simple. Make sure 
the Test Application GUI for each particular module type is already installed in the 
RxT Carrier. 

You may receive new Option Files via email, USB drives or download it from an FTP 
server. Load this opt file to the root of a USB drive. 

•	 Turn the RxT off.

•	 Insert the MTT module with matching serial number in the RxT Carrier (MTT 
module and opt file name must contain the same serial number)

•	 Insert the RxT Carrier in the RxT Platform

•	 Turn the RxT on.
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•	 Wait for the Test Application GUI to start.

•	 From the Test Application GUI select Tools or press F5 (use F6 when in MTT 
Forward Compatibility Mode.)

•	 Select Software Option.

•	 Insert the USB drive containing the opt file in the RxT Platform, wait for it to be 
recognized, and press OK. The Option File matching the test module’s Serial 
Number must be loaded in the USB drive’s root.

•	 Identify the section named “New Software Option Location” located at the bottom 
of the Software Option window.

•	 Set the source as USB.

•	 Press LOAD.

•	 All the licenses originally purchased for the MTT module are now registered with 
this particular RxT Carrier

•	 Repeat the process with any other modules you want to use with this RxT Car-
rier.
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2.9	 Software Options 

To Install a New Option

1.	 Purchase a new RxT option from Sunrise Telecom; you will be asked to provide 
the RxT’s serial number.

2.	 Sunrise Telecom will mail you an option file, with a name in the format: rxt-
gigexxxxxxx.opt, where xxxxxx is the serial number.

3.	 Go to the RxT Platform Desktop (blue screen) using Alt+F6.

4.	 Select System.

5.	 Select RxT Tools.

6.	 The screen will flash momentarily and a new section will open.

7.	 Insert an USB drive to the RxT Platform, wait for it to be recognized, and press 
OK. The Option File matching the system’s Serial Number must be loaded in 
the USB drive’s root.

8.	 Select the Software Option tool.

9	 Identify the section named “New Software Option Location” located at the bottom 
of the Software Option window.

10.	Set the source as USB.

11.	Press LOAD.

Test options may be purchased from Sunrise Telecom. Contact Customer Service. 

Is this option enabled?
•	 Checked: Option Enabled

•	 Not checked: Disabled 

Options Example

Option Type Description

Wireless Network System Enable wireless network-
ing.

Bluetooth System N/A

Remote User Access System Control RxT GE from a 
remote browser

Dual Port 1000Base-T 
[RJ45]

Test Ports Optional hardware

Dual Port 1000Base-X 
[SFP]

Test Ports Optional hardware

Dual Port 1000Base-FX/
LX 

Test Ports Optional hardware

*Layer 3 & Advanced IP 
Test

Advanced Testing Test option

*Multiple Streams (8) Advanced Testing Test option
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New Software Option
*Software test options must be loaded. You will be provided with an option key. Use 
the next selection to tell RxT where to find the software option key (for Step 7 in the 
procedure above).

Item Description

Destination* Retrieves the file from an external USB drive or the Default 
Location (the RxT’s internal hard drive). See the Hardware 
Notes.

Load Activate the option; Press Load to have the RxT module look 
for and load your option key.

*Hardware Devices: Only one may be used at a time. 

2.10	 RxT Software Options - Location:xxx pop up window

Once you press load to retrieve your software option key, a Software Options window 
pops up. It shows all of the options qualified to work on this test set. 

To enable options: 

Check marks appear next to the installed options. 

Check ‘Accept new options’. 

Close the window. 

A popup window displays details about new options file.

•	 Part Number, Time Generated 

Access this Software Options tab in the System menu.
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2.11	 System and Module Upgrade

View the system and module’s current version as well as a list of other available ver-
sions, and install updates. For information on loading and upgrading MTT modules 
in the RxT Platform, see Loading MTT Modules into RxT.

RxT Platform’s System Software Update

1.	 If using LAN, connect the cable from the RxT to the Ethernet data outlet. 

2.	 Turn the RxT ON and wait until the Test Application Interface (GUI) shows the 
main test menu.

3.	 Use the QuickSwap function (Alt+F6) to access the system’s desktop.

4.	 Confirm that you have Internet connection (LAN or Wi-Fi) by accessing Network 
Setup or Wireless Network Setup to verify that a valid IP address is shown and 
Wi-Fi shows CONNECTED status, then go back to the main system desktop 
screen.

5.	 Select System.

6.	 Select RxT Tools.

7.	 Select Software Upgrade.

8.	 Press Version List. If newer software versions are available in the server, they 
will all be displayed. Older software versions may not be shown for downgrade.

9.	 Select the latest (higher) software version available.

10.	Check Reboot

11.	Verify that the AC/DC charger is plugged in (the battery icon on the top right of 
the screen would show an AC plug inside the icon).

12.	Press Install, and wait for the whole process to finish. It may take a few minutes, 
depending on the network connection speed and the size of the update.

13.	The unit should reboot when finished.

RxT Test Modules’ Software Update

Each module’s Test Application GUI needs to be updated independently. Test Mod-
ules can be updated via Ethernet/Internet or USB Drive.

1.	 Insert the test module that needs to be updated in the RxT Platform.

2.	 If using LAN, connect the cable from the RxT to the Ethernet data outlet. 

3.	 If using USB Drive, plug it in one of the USB ports and wait for confirmation that 
it has been recognized and ready to use.

4.	 Turn the RxT ON and wait until the Test Application Interface (module GUI) 
shows its main test menu.

5.	 From the Test Application GUI Press Tools or F5 and select Module Upgrade.

6.	 Press Version List. If newer software versions are available in the server, they 
will all be displayed. Older software versions may not be shown for downgrade. 
If for some reason a downgrade is required, please contact Technical Support.
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7.	 Select the latest (higher) software version available.

8.	 Check Reboot

9.	 Verify that the AC/DC charger is plugged in (the battery icon on the top right of 
the screen would show an AC plug inside the icon).

10.	Press Install, and wait for the whole process to finish. It may take a few minutes, 
depending on the network connection speed and the size of the update.

11.	The unit should reboot when finished.

Notes
•	 Wi-Fi does not reconnect during the boot up process. Go to \System \RxT Tools 

\Wireless Network Setup to reestablish a connection with an access point.

•	 LAN (DHCP) may not reconnect automatically if Ethernet cable is not plugged 
in during the boot up process. Go to \System \Network Setup to reestablish a 
connection.

 

2.12	 System Administrator Setup

System Information

•	 Hardware Version

•	 Serial #

•	 MAC Address #

Module Information

•	 Hardware Version

•	 Serial #

•	 MAC Address #

•	 Port-1/2/3 MAC:

Activate administrator mode: When checked, a Password entry window pops up. 
Enter the administrator password.
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2.13	 System Status

Get details on RxT system performance. Press Tools > System Status.

General

Statistic Meaning

File Usage Percentage of system currently in use.

Memory Usage Percentage of system RAM in use.

Temperature Unit temperature; normal range is 0˚C to 45˚C.

Power

Statistic Meaning

AC Power On if the unit is plugged in; Off if it is not.

Total Charge The percentage of charge remaining in the battery; see the 
Battery icon.

Time to Full Charge	 When running on battery, approximately how long it will take 
to recharge the battery.

Remaining Time When running on battery, approximately how long the battery 
will last.

Version Information

Statistic Meaning

System Version RxT system version

System Serial No. RxT system serial number

Module Version 10GE module software version

Module Serial No. 10GE module serial number

Module CPLD Hardware history information; provide to Customer Service 
on request.
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2.14	 GeoTrace GPS

Get RxT location information via GPS data and location tags. This is a Tools and 
system desktop feature (ALT + F6).

Status Signal quality status

Satellites Number of satellites signal routed through.

GMT Date GMT to local time converters may be found on the Internet.

GMT Time GMT to local time converters may be found on the Internet.

Latitude Location converters may be found on the Internet

Longitude Location converters may be found on the Internet

Altitude Measures the unit’s distance from the center of satellite orbit. 
Set the altitude measure display to Meters or Feet. 

Display Format Set the latitude/longitude measure display to Degrees or Seconds.

Map It: A location window pops up, showing you RxT’s physical location on a map. 
You must be connected to the internet to use this feature. 

2.15	 File Manager

The computer system runs on Linux, with a Gnome Nautilus shell. Application help 
can be found under the MultiMedia icon. 

A few pointers for non-Linux users:

•	 Double clicking is not necessary; one click on an icon will open its feature.

•	 The main directory is /home/sunrise.

•	 Each application (such as a web browser or multimedia player) fills the entire 
screen; use Alt + F6 to move between applications, and remember to quit each 
one when you finish using it.

•	 A hierarchial view of the files is available under Tree in the left side menu (the 
same location as the default Places).

•	 Use File > Open to browse for and open files.

•	 On the top menu bar, View includes zoom functions and a reset function.

•	 If you get lost, Back is usually available in the upper menu bar, which will take 
you back a screen; keep pressing Back until you get somewhere familiar. 
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2.16	 Network Setup

Configure system settings if necessary. Access this window under System > Net-
work Setup.

IMPORTANT NOTE: These settings apply to the RxT module’s own LAN port, NOT 
the test ports. Changing these settings may cause the module to lose connection 
with the system.

Ethernet Port

Parameter Details

Admin IP Enter the IP address for the RxT module.

Subnet Mask Enter the subnet address for the RxT module, if appro-
priate.

Gateway Specify the gateway address for the RxT. Used for static 
IP.

DHCP Enabled RxT automatically retrieves the appropriate IP address 
when connected to a LAN. When enabled, the previous 
three items are grayed out.

MAC Address View the LAN port’s MAC address.

DNS servers

Parameter Details

Primary DNS Server Specify the local primary (master) DNS server address. 
Enter an address directly, using the number pad which 
pops up. 
The secondary Server is a server that obtains informa-
tion about a zone from a Primary Server via a zone 
transfer mechanism.  Sometimes known as a Slave 
Server.

Secondary DNS Server Specify the secondary (slave) DNS server address.

Advanced Configuration

Parameter Details

Speed and Duplex Auto: Let RxT find the maximum settings.

10Base T/Half, 10BaseT Full, 100BaseT/
Half, 100BaseT/ Full: Set RxT at a spe-
cific speed and duplex.

 Press Apply to save the settings and close the window. 

Press Close to close the window without saving changes.
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2.17	 Wireless Network Setup

Configure a wireless Ethernet network connection. On the system desktop, select 
Tools > Wireless Setup, or access through the computer desktop.

Wireless Network:  AP Settings

Parameter Options Details

SSID Use the soft keypad to enter the name 
of the wireless network.

Encryption Type WPA, WPA2, None Select the type of encryption to use to 
protect your data.

Network Key Enter the network key (password) if 
required.

AP MAC Address Enter the MAC Address of your Wire-
less Access Point, if required.

Source IP Mode: Choose Dynamic (DHCP) or Static IP mode.

Press Apply to change the Source IP Mode. The settings will refresh.

Static/DHCP Network Settings

Parameter Options Details

Admin IP Use the soft keypad to enter the ad-
dress, when DHCP is Off.

Subnet Mask Use the soft keypad to enter the ad-
dress, when DHCP is Off.

Gateway Use the soft keypad to enter the ad-
dress, when DHCP is Off.

MAC Address NA: DHCP
Static: View the LAN 
port’s MAC address.

Primary DNS Specify the local pri-
mary (master) DNS 
server address.

DHCP
Enter an address directly, using the 
number pad which pops up.

Secondary DNS Specify the second-
ary (slave) DNS 
server address.

DHCP
The secondary Server is a server that 
obtains information about a zone from 
a Primary Server via a zone transfer 
mechanism. Sometimes known as a 
Slave Server.
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Link Status
View network status, and manage your connections.

Network Name Common language name of the network.

Status Network connection status: CONNECTED, DISCONNECT-
ED.

Leased Time View elapsed lease time; the amount of time that a network 
user/client will be allowed to remain connected to the router 
using their current dynamic IP Address.

Scan RxT scans for available wireless networks.

Connect Connect to the located link.

Network Buttons

Connect/Disconnect •	Highlight the network you want to connect to, then press 
‘Connect’. RxT 10GE will attempt to connect.

•	Disconnect from the network.

Scan RxT 10GE scans for available wifi networks. An “Avail-
able” network can be connected to if you have the correct 
configuration ion. See   

Buttons
Scan: RxT scans for available wifi networks. An “Available” network can be con-
nected to if you have the correct configuration ion. 

Connect

•	 Highlight the network you want to connect to, then press Connect. RxT will at-
tempt to connect.

•	 Disconnect from the network.
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